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Cordless Phones Vs. 
Wireless Network 
by Art McRowe, Akron-
Canton PC Users Group 
 
The world is networking. Wireless 
is very attractive for its ease of in-
stallation, mobility and rapid cost-
effectiveness. The alternative is a 
hardwired network. Hard wire is 
cheaper, faster networking, more 
secure and less easy to install. I 
live in a one story house and the 
rooms with a computer are all less 
than 30 ft. from my main com-
puter in the basement. Relatively 
easy, but still a pain. We went 
with wire. 
 
My house uses two fixed desktop 
computers. We have children visit 
with laptops, all with IEEE802.b 
built-in. Their computers also have 
10-100 Mb Ethernet outlets, just 
like our desktops. 
 
Our fixed usage would have 
worked well with either wireless or 
wired networking. Mobility is prob-
lematic. How do I know? I have a 
cordless phone which works in the 
2.4 GHz spectrum, just like the 
802.b and 802.g wireless network-
ing protocols. My cordless phone 
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from where in the house I have the phone does not work worth a darn 
where my downstairs computer is.  
 
Furthermore, near my computer is my downstairs microwave oven, which I 
dearly love for heating cups of coffee. Folks, the 2.4 GHz spectrum band is 
where water or more specifically, the –OH bond of water, alcohols (sugars 
and starches and cellulose (like wood)) and similar structures absorb en-
ergy. This is really infrared. Remember, wood is water, cellulose. Concrete 
is water. Gypsum (wall-board) is water. This is why they are used in fire-
safety situations- water slows combustion – and absorbs in the 2.4 GHz 
band. So is the earth with its water. Rain, even fog, between buildings will 
absorb signal strength between buildings! 
 
Having said that, wireless is still desirable, if not a requirement, for two-
storied homes for retrofitting. Will it work for you? Buy (well don’t buy), 
beg, borrow or steal a wireless phone using the 2.4 GHz band. There are 
wireless phones using the 900 MHz and the 5 GHz ranges, too. Put the base 
phone where you’ll want your central station. Then try it out all over the 
house and grounds. Where this phone works is probably a good chance 
your wireless will work. 
 
You decide on wireless, OK. Get rid of your 2.4 GHz phones and switch to 
either 900 MHz or 5 GHz phones. Don’t use your microwave nearby or at 
the same time as you’re networking on wireless. 
Simple, no. Sorry, there is only so much frequency spectrum available. And 
we are stuck with what we’ve gotten allocated! Want to go back to the ear-
lier 802.11a specifications? Well watch out, the “a” uses the 5 GHz spec-
trum. Radiated power of all these devices are in the same 1000 mw range. 
So they compete with each other. I have read that this competition does 
not definitely kill the opposing use; it may just slow down the networking 
with error correction. 
Remember, there are repeaters for the 802.11g transmitters available. 
They will extend the range to problem areas. But the theoretical speed is 
cut in half. In practice, it’s even slower than that. That is because the 
same bandwidth is used to first receive, and then, rebroadcast a particular 
data stream. 
Since I choose a wired system, I am not an expert for wireless. But I’d try 
out the 2.4 GHz phone first, then try to borrow an 802.11g system to ex-
periment with. And remember, a hard-wired system will work with a wire-
less extension in the problem area of the house. There is a solution! 
 
There is no restriction against any non-profit group using this article as long as it is kept in 
context with proper credit given the author.    
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WHAT IS APCUG? 
by Charlotte Semple, President / Editor,  
Los Angeles Computer Society, California 
 
The Association of Personal Computer User Groups (APCUG) is an interna-

tional, platform-independent, volunteer-run nonprofit body devoted to help-
ing user groups offer better services to their members.  APCUG is an or-
ganization dedicated to helping member computer user groups succeed.  It 
helps to foster communications by operating as an informal network be-
tween user group organizations and also with companies that provide com-
puter-related and Internet-related goods and services. APCUG also assists 
member groups in the fulfillment of their educational missions and activities 
by sharing with officers of member user groups the knowledge of what it 
takes for user groups to better serve their members. APCUG operates as a 
50l(c)(3) non-profit organization.   

 
Is APCUG a user group?  
Absolutely not. APCUG membership consists of user groups, not individual 

members. While APCUG facilitates information to the user groups and pro-
vides information about possible services, it is up to the individual user 
groups to offer the services to their memberships. 

 
Is membership in APCUG limited to user groups of any particular operat-

ing system or platform? 
No. APCUG membership is open to all microcomputer user groups.  Some 

of the members of APCUG are computer societies that serve many different 
platforms. 

 
How did APCUG get started?  
The genesis of APCUG came from a series of meetings by representatives 

from various user groups around the country. Whenever user group officers 
and directors met, there were continual discussions about the need to im-
prove communication between the groups and to share information such as 
newsletters, strategies, ideas, etc. As a first step, the presidents from three 
user groups — Boston Computer Society, Capital PC User Group, and Hous-
ton Area League of PC Users - organized the First Annual User Group Sum-
mit meeting at the 1986 Fall Comdex.  As a result of the feedback from that 
first Summit meeting and subsequent meetings among user group repre-
sentatives, the leaders of 15 user groups met in Seattle in October 1987, 
and proposed the formation of an association for the purpose of fostering 
communication among and between user groups. That proposal was pre-
sented before 130 representatives from 50 user groups at the Second An-
nual User Group Summit Meeting in November 1987, and was unanimously 
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approved. 
 
What is the organizational structure of APCUG? 
The primary governing body of APCUG is a 9-person Board of Directors. 

Each Director is elected for a three-year term, with one-third of the 
Board elected each year. The Board of Directors is responsible for the im-
plementation of APCUC activities and daily management of the organiza-
tion. A 15-person Board of User Group Advisors, each of whom is elected 
for a two-year, staggered term (one-half of the Advisory Board is elected 
each year), is the ombudsman for their assigned groups and is responsi-
ble for proposing new activities or directions for APCUG and for advising 
the Board of Directors on user group concerns.  All of the members of the 
Board of User Group Advisors are active participants in APCUG-member 
user groups.  In addition, each Member User Group designates a person 
to act as a representative to APCUG. The APCUG user group rep-
resentatives are responsible for keeping their group’s officers and mem-
bers up-to-date with information sent to them by APCUG, as well as 
keeping their group’s information in the APCUG database current.  They 
also receive the yearly ballot. 

 
What kinds of things does APCUG do? 
APCUG has established and maintains a National Registry of PC User 

Groups and provides this information to participating groups, publica-
tions, and vendors. By making this information available, more groups 
will be able to take advantage of services provided by manufacturers, 
publishers, and publications. APCUG encourages hardware manufacturers 
and software publishers to establish formal user group support programs 
and provides them listings of APCUG member user groups to facilitate the 
implementation of such programs. 

 
APCUG provides a number of Internet services, including web pages 

with information about APCUG, mailing lists for User Group officers to 
communicate with their peers, Web Space for User Groups, and a num-
ber of other services, all accessible through http://www.apcug.org. 

 
APCUG also plans and coordinates user group activities at major com-

puter shows and expositions.  These activities include a series of pro-
fessional development seminars for user group officers; computer prod-
uct showcase and exposition; the APCUG Summit Meeting held during the 
Fall conference; computer industry sponsored technology briefings; and 
sponsored breakfasts, luncheons and receptions. APCUG serves as a 
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clearinghouse for user group resources and vendor programs. In this 
way, each user group will not have to re-invent the wheel when it comes 
to creating something like a new member brochure or novice user disk-
ette.  Similarly, APCUG has developed a vendor database that summa-
rizes the various programs and identifies the contact person within each 
company. User groups can then contact the vendors directly to enroll 
their groups into the programs. 

 
Does APCUG take stands on issues or lobby? 
No. It is more appropriate for individual user groups and not an 

umbrella organization to take positions on issues. As an information 
clearinghouse, the APCUG can, however, facilitate the exchange of 
communication on issues and help put user groups in contact with 
one another. Since the policy in most user groups is that only the 
Board of Directors can establish policy, it would be inappropriate 
and harmful for the APCUG to take positions on behalf of its member 
organizations. If it is to be successful, it is essential that APCUG not 
interfere or encroach upon the inherent responsibilities of its user 
group members. 

 
How does APCUG pay for its directors, officers, staff, and offices? 
Like many user groups, APCUG is a non-profit organization that 

depends primarily on volunteer effort.  APCUG does not maintain its 
own physical offices but instead contracts for services on an as 
needed basis.  APCUG employs an administrative assistant who han-
dles updating the database, sends renewal invoices to groups, etc.   
All director and officer positions are unpaid volunteers.  Thus far, 
many people have stepped forward from individual user groups and 
volunteered their services to APCUG. This spirit is expected to con-
tinue.  

 
How much does it cost to join APCUG? 
Each APCUG member user group is assessed an annual membership fee 

of $50 to help defray administrative and operational expenses. 
 
Is my group a member of APCUG?  
Yes. Most APCUG member groups display the APCUG logo on their web 

page and in their newsletter. 
 
APCUG Member Services  
To help new User Groups to form, APCUG offers a collection of informa-

(Continued from page 4) 
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tion, including sample Articles of Incorporation and Bylaws.  APCUG puts 
on one or two national events each year. The many Round Table Pro-
grams offered are set up to help leaders in running their user groups.  
There are also Regional Conferences held during the year where user 
groups can also meet to exchange ideas, share the highs and lows of 
running a user group, meet vendors, etc. on a more local level. 

 
APCUG provides web space and other web services for user groups that 

have trouble finding a local ISP to host their web page  The WebBoard 
offers a ListServe for groups to contact their members, chat accessibility 
for on-line meetings, and conferences for a group’s guru to answer tech-
nical questions. 

 
APCUG publishes APCUG Reports four times a year, and copies are 

mailed to selected officers of all APCUG member user groups.  It contains 
many articles to help officers do their jobs better. These reports are also 
published on the Net. 

 
Newsletter editors can often use more content for their newsletters. The 

APCUG Editorial Committee emails four to six articles each month to all 
editors in APCUG member user groups.  These articles can then be pub-
lished in the group’s newsletter.  Articles are usually written by user 
group members from around the world. 

 
The monthly NOOZ newsletter from your group’s advisor contains infor-

mation about APCUG and the group’s region. 
 
Tips & Tricks for Running your User Group are special articles written to 

provide assistance to a member user group on some aspect of running a 
User Group.  Frequently they will be based on material presented at a 
Round Table session at an APCUG or regional conference. 

 
APCUG maintains a Presentation-in-a-Box list that contains information 

about vendor-provided material that user group members can use them-
selves to make a presentation at their meeting. 

 
Occasionally, member groups receive information about discounts being 

offered to their members.  Many vendors have special programs set-up 
for user group members that offer continuous discounts.  

 
APCUG maintains a user group locator on its website which anyone can 

(Continued from page 5) 

(Continued on page 7) 



7 

use to find another user group to arrange joint projects, arrange a ven-
dor tour for several groups, and enable officers to find other user group 
officers in their area to interact with to discuss topics of interest to the 
groups. 

 
The APCUG logo is available for use by APCUC member groups. Differ-

ent sizes of transparent GIF files (color) for the web, and BMP and TIP 
files (gray scale) for print use are included, as well as AI, EPS, and PSD 
formats for those who need different sizes or formats than those pro-
vided. 

 
Help is just an e-mail away – groups can contact their regional advisor 

or a member of the Board of Directors.  All officers are willing and avail-
able to assist APCUG-member groups. 

 
Compiled from information gleaned from the APCUG Website, http://

www.apcug.org. 
 
There is no restriction against any non-profit group using this article as long as it is 

kept in context with proper credit given the author.  The Editorial Committee of the As-
sociation of Personal Computer User Groups (APCUG), an international organization of 
which this group is a member, brings this article to you. 

 
Editor’s Note: Your club, ACPCUG, is a member of APCUG. Your 

dues support APCUG. APCUG has awarded ACPCUG (confusing?) 
several awards for community service back when we were dis-
tributing older PC’s and educating PC usage at several venues. 
They presently are valuable to us by supplying newsletter articles 
that we use monthly right here in our newsletter! 

 AWMcRowe. 
 

(Continued from page 6) 
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Ergonomic Gizmos 
by John R. Chait D.C., drchait@hotmail.com 
Member of the Sarasota Personal Computer Users Group, Inc., 
Florida  

How do you use your laptop? 
 
Are you an occasional user who works on your laptop for short peri-

ods of time, or are you a full-time user with the laptop as your main 
computer?  Occasional users will have less ergonomic risk of problems 
developing than full-time users. 

 
Laptop Posture - laptops violate basic ergonomic design require-

ments, so using a laptop is a tradeoff between poor neck/head posture 
and poor hand/wrist posture. 

 
Occasional Users- Find a chair that is comfortable and that you can 

sit back in.  Position your laptop in your lap for the most neutral wrist 
posture that you can achieve.  Angle the laptop screen so that you can 
see it with the least amount of neck deviation. 

 
Full-time Users- Position this on your desk in front of you so that 

you can see the screen without bending your neck.  This may require that 
you elevate the laptop off the desk surface using a stable support sur-
face, such as a computer monitor pedestal.  Use a separate keyboard and 
mouse.  You should be able to connect a keyboard and mouse directly to 
the back of the laptop or to a docking station. 

 
Use the keyboard on a negative-tilt keyboard tray to ensure a wrist 

neutral posture.  Use the mouse on an adjustable position mouse plat-
form.   The design of laptops violates a basic ergonomic requirement for 
a computer, namely that the keyboard and screen are separated.  In the 
early days of personal computing desktop devices integrated the screen 
and keyboard into a single unit, and this resulted in widespread com-
plaints of musculoskeletal discomfort.  By the late 1970's a number of er-
gonomics design guidelines were written and all called for the separation 
of screen and keyboard.  The reason is simple, if the keyboard is in an 
optimal position for the user, the screen isn't and if the screen is optimal 
the keyboard isn't.  Consequently, laptops are excluded from current er-
gonomic design requirements because none of the designs satisfy this 
basic need.  This means that you need to pay special attention to how 

(Continued on page 9) 
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you use your laptop because it can cause you problems. 
 
Copyright 2003. This article is from the October 2003 issue of the 

Sarasota PC Monitor, the official monthly publication of the Sarasota Per-
sonal Computer Users Group, Inc., P.O. Box 15889, Sarasota, FL 34277-
1889. Permission to reprint is granted only to other non-profit computer 
user groups, provided proper credit is given to the author and our publi-
cation. We would appreciate receiving a copy of the publication the re-
print appears in, please send to above address, Attn: Editor. For further 
information about our group, email: admin@spcug.org/ Web: http://
www.spcug.org/ 

 
There is no restriction against any non-profit group using this article as long as it 

is kept in context with proper credit given the author.  The Editorial Committee of the 
Association of Personal Computer User Groups (APCUG), an international organization of 
which this group is a member, brings this article to you. 
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Computer Memory 
by Brian K. Lewis, Ph.D. 

Member of the Sarasota Personal Computer Users Group, Inc., 
Florida 

 
Occasionally the question arises as to how much memory can be 

put in a computer. The answer is "it depends". It depends on just what 
you mean by memory (RAM or hard disk), what operating system you 
are using and the capabilities of your computer's motherboard and its 
chipset. When I talk about memory I am not referring to the permanent 
storage of programs and data on the hard disk. Rather, I refer to the ran-
dom-access memory or RAM. This is the memory provided by memory 
chips seated in slots on the motherboard of today's computers. Anything 
stored in RAM disappears when the power is turned off, so it is referred 
to as volatile, or temporary, memory. 

 
If you want to upgrade the memory in your computer you have to 

be able to determine the memory type as well as the size, pins and 
speed, the number of slots available on your motherboard and the maxi-
mum amount of memory that your system can address. In general, this 
varies with the age of your computer. So let's look at these components 
in a little more detail. (Please note that although my remarks refer to In-
tel's Pentium series central processors, they also generally apply to the 
equivalent AMD processors.) 

 
Early Pentium based computers had a CPU bus speed of 66 MHz 

(megahertz) and a PCI I/O bus speed of 33 MHz. These values relate to 
the speed of data movement within the central processor and transmis-
sion to and from peripherals such as the memory bank. In some cases 
transfer to and from memory was at 50 MHz. Pentium computers gener-
ally had four slots which were arranged as two banks. This meant that 
memory had to be installed in units of two. The memory chips were 72 
pin DRAM (dynamic RAM) or SIMM (single in-line memory modules) mod-
ules. Many of these computers could support four DRAM modules of 32 
MB (megabytes) for a maximum of 128 MB of RAM. There were some 
motherboards built for Pentium 5 systems that had 2 or 3-168 bit DIMM 
slots in addition to the 72 pin slots. However, you could not use both the 
72 pin and 168 pin slots, only one or the other. These systems would 
support either 128 or 256 MB of memory. However, at the time, many 
Pentium/Pentium II computers were sold with only 16 MB of RAM and 
Windows 95. Later, with Windows 98 the basic memory was 32 MB. In 

(Continued on page 11) 
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both cases, this is a less than optimum amount of memory for these oper-
ating systems. The first Pentium computers had a 32 bit address space 
which was theoretically capable of addressing 4 GB (gigabytes) of memory. 
However, none of the motherboards manufactured for these computers car-
ried any such memory capacity. 

 
The next generation of computers carried faster CPUs and chipsets 

along with faster bus speeds. For example the Intel 440 series chipsets 
were capable of working with CPUs with speed of 233 - 333 MHz at a bus 
speed of 66 MHz or with 350-450 MHz processors at a bus speed of 100 
MHz. These motherboards generally had 3- 168 pin slots and would support 
a maximum of 384 MB of RAM. As the address space of the CPU was in-
creased to 36 bit, the maximum addressable memory was 64 GB. However, 
in practice some computers running Win98 would not recognize more than 
256 or 384 MB of RAM. This problem has been ascribed to the chipset de-
sign and problem with the L-2 cache. So some caution is recommended if 
you intend to upgrade the memory in a Pentium II or older system With 
some of the Pentium III class computers there was an additional increment 
in bus speed to 133 MHz. The motherboards had 2 to 4 168-pin memory 
slots. The maximum usable memory of such systems ranges from 512 MB 
to 1 GB. These motherboards for this CPU class are generally able to use 
100 - 133 MHz DIMMs. The 133 MHz DIMMS are capable of working at the 
100 MHz speed. The Pentium 4 motherboards came with a whole new array 
of chipsets and memory chip types and speeds. The maximum memory now 
ranges up to 4 GB. Intel's initial Pentium 4 motherboards required the use 
of RDRAM or Rambus DRAM memory chips. RDRAM is a serial memory 
technology that arrived in three speeds, PC600, PC700, and PC800. RDRAM 
designs with multiple channels, such as those in Pentium 4 motherboards, 
are currently the fastest in memory throughput, especially when paired with 
the newer PC1066 RDRAM memory. A Rambus channel is 2-bytes wide, so 
we get a maximum 1.6GB/s transfer rate for a single RDRAM channel using 
PC800 RDRAM or 2.1GB/s for PC1066. The other form of memory chip is 
the double data rate DRAM. Intel and other manufacturers now have moth-
erboards and chipsets that can utilize these memory modules. They are less 
expensive than the RDRAM. DDR memory modules are named after their 
peak bandwidth - the maximum amount of data they can deliver per second 
- rather than their clock rates. This is calculated by multiplying the amount 
of data a module can send at once (called the data path or bandwidth) by 
the speed of the front side bus (FSB). The bandwidth is measured in bits, 
and the FSB in MHz. Note that the RDRAM bandwidth is in bytes. One byte 
is equal to 8 bits. 

 

(Continued from page 10) 
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A PC1600 DDR memory module can deliver bandwidth of 1600Mbps. 
PC2100 (the DDR version of PC133 SDRAM) has a bandwidth of 2100Mbps. 
PC2700 modules use DDR333 chips to deliver 2700Mbps of bandwidth and 
PC3200 - the fastest widely used form in late 2003 uses DDR400 chips to 
deliver 3200Mbps (3.2 Gbps) of bandwidth. You may see the term "dual 
channel" applied to memory. When properly used, the term refers to a DDR 
motherboard's chipset that's designed with two memory channels instead of 
one. The two channels handle memory-processing more efficiently by utiliz-
ing the theoretical bandwidth of the two modules, thus reducing system la-
tencies, the timing delays that inherently occur with one memory module. 
For example, one controller reads and writes data while the second control-
ler prepares for the next access, hence, eliminating the reset and setup de-
lays that occur before one memory module can begin the read/write proc-
ess all over again. 

 
Consider a model in which data is filled into a container (memory), 

which then directs the data to the CPU. Singlechannel memory would feed 
the data to the processor via a single pathway at a maximum rate of 64 bits 
at a time. Dualchannel memory, on the other hand, utilizes two pathways, 
thereby having the capability to deliver data twice as fast or up to 128 bits 
at a time. The process works the same way when data is transferred from 
the processor by reversing the flow of data. A "memory controller" chip is 
responsible for handling all data transfers involving the memory modules 
and the processor. This controls the flow of data through the pathways, 
preventing them from being over-filled with data. Now that you are totally 
confused by all this memory type and speed terminology, let's look at the 
next question. 

 
How much memory should you have in your computer? The answer 

is: probably as much as your motherboard and chipset can handle. For the 
newest motherboards, that may be excessive unless you are involved in 
digital video editing or graphic design. For most home users running WinXP 
or Win2K I would recommend 512MB up to 1GB. So why those figures? I 
have found that WinXP uses over 200 MB of RAM for its own files, if that 
much is available. So on a 256 MB system that leaves very little for other 
applications and data. The net result is a lot of swapping with the virtual 
memory space on the hard drive. That slows everything down. In WinXP the 
Windows Task Manager (bring up by pressing CTRLALT-DEL) shows your 
current performance and the amount of memory available in real time. With 
512 MB and several programs running, I have over 300 MB of real RAM 
available. That greatly increases the responsiveness (speed) of the system 
as moving data to and from RAM is many times faster than using a hard 

(Continued from page 11) 
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disk. The Page File window shows you the virtual memory swapping your 
system is doing. At the moment, mine is zero. 

 
You can do similar analyses on Win98/WinMe systems. The System 

Monitor application that comes with Windows can supply this information. 
 
However, you may need to modify it to get the memory info you 

want. Go to Start-Programs-Accessories-System Tools and select System 
Monitor. If this selection is not available on your menu, then you need to 
install the program from your original Windows disk or from \WindowsOp-
tions\Cabs file. You do that from the Control Panel (Add/ Remove Software) 
and Windows Setup. Once you have the system monitor you can ADD 
memory information by clicking on Edit, then add item. Select Memory 
Manager. The individual items that will be the most helpful are: allocated 
memory, unused physical memory, page files in/ out, swapfile in use or 
swappable memory. The kernel reading tells you how much of your CPU ca-
pacity is being used. Generally, Win98/WinME will do very well with 256 MB 
- 384 MB of RAM. You just have to be certain that your motherboard and 
chipset can support this much RAM. Most of the home computers I have 
worked on really don't have enough RAM for the most efficient operation. 
Does Yours? 

Dr. Lewis is a former university & medical school professor. He has been working 
with personal computers for more than thirty years.  He can be reached via e-mail at 
bwsail@yahoo.com or voice mail at 941/925-3047. 

There is no restriction against any non-profit group using this article as long as it is 
kept in context with proper credit given the author.  The Editorial Committee of the Asso-
ciation of Personal Computer User Groups (APCUG), an international organization of which 
this group is a member, brings this article to you. 

 

(Continued from page 12) 



14 

Accessibility for Everyone 
by Billy Mabray 

Oklahoma City PC Users Group 
eMonitor - February 2004 

 
Many people, including a lot of Web designers, think Web-site ac-

cessibility is only about making sites work for blind users with screen 
reader software. Accessibility should be about all of us. There is a wide 
range of physical conditions that can make using the Web difficult. The 
Internet can be a frustrating place when you have poor eyesight, color-
blindness, or trouble using a mouse. You may not fall into any of these 
categories right now, but consider this statistic: 100% of Internet users 
are growing older. At some point, we will all need help navigating the 
Web. 

There are many things that can be done to make the Web more ac-
cessible. Some of those things are already built into your Web browser. 
Others require Web designers to implement accessible features on their 
Web sites. If you are one of the many people who has difficulty using the 
Web, you will want to know what help is out there. 

One of the biggest complaints people have is that text is too small. 
It is also the easiest to remedy. If you are using Internet Explorer, 
choose View>Text Size from the top menu. Also, if your mouse has a 
scroll wheel, you can hold the CTRL key and scroll up and down to 
change the text size. Now, this will not work on all Web pages – later, we 
will discuss why that is and what Web designers can do about it. The Net-
scape/Mozilla browser, however, can change text size on all Web pages. 
Choose View>Increase Text Size, or hold CTRL and press the + key. 

There are many shortcut keys available for those who have diffi-
culty using a mouse. For example, the backspace key will take you to the 
previous page, F5 will reload your current page, and ALT plus the Home 
key will take you to your home page (the page set to load when you 
open your browser). Also, if you have gone back to a previous page, ALT 
plus the right arrow will take you forward again. Another useful key on 
any Web page is the TAB key. You can use the TAB key (and SHIFT plus 
TAB to go in reverse) to quickly navigate forward through all the links 
and form fields on a Web page. Once you have tabbed to a form element, 
other keyboard shortcuts may come in handy. For drop-down boxes, you 
can use the up and down arrows to highlight your selection.  For radio 
buttons or checkboxes, use the space bar to select your choice. If you 
are using a recent version of Netscape/Mozilla, you can also use “Find As 
You Type.” Start typing at any page and it will automatically do a search 
for what you are typing on that page. 
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Some people, particularly the colorblind, find Web sites hard to use 

because the color of the text does not contrast enough with the back-
ground colors. If the color scheme of your favorite Web site makes it dif-
ficult to read, you can override that as well. You will find this under 
Tools->Options or Edit->Preferences, depending on your browser. You 
can set your default fonts, font sizes, and page colors. You can also spec-
ify that your defaults always override what is set by the Web page. 

While these browser features can be helpful, there is still much 
Web designers must do to make their site accessible to the widest possi-
ble audience. A good example is text sizing. If Web designers use fixed 
text sizes – sizes that specify an absolute unit of measurement, such as 
points or pixels – on their pages, Internet Explorer users cannot change 
their text size as I described earlier. Web designers can, and should, use 
relative text sizes to make their pages more accessible. Designers who 
prefer to use absolute sizes for text should provide a “style switcher.” 
This is a link on the page that allows the site's visitor to make the text 
bigger and saves that preference in a cookie. 

Another accessibility feature that some designers use is access 
keys. These are just like the shortcut keys I mentioned earlier; except 
they are defined by the Web page you are on. For example, the designer 
could define ALT plus 4 to take you directly to the search function. If you 
visit a site regularly and know their access keys, they can be useful. 

Web designers should also use labels for forms. Labels make the 
text next to a form field clickable, just like the field itself. For example, if 
a form has a checkbox that reads, “Click here to subscribe,” and that text 
is set as a label, the user can click anywhere on that text to check the 
box. It can be very helpful to have a larger target when trying to click 
things with a mouse. 

We still have a long way to go before the Web is accessible to eve-
ryone. But now you know some of the helpful features you have at your 
fingertips already, and you know what to ask for from the Web sites you 
frequent. Hopefully, as users learn what they can do, and designers learn 
what they need to do, we can all enjoy the Web a little more.   

 
Billy Mabray and his wife, Angela, own Smart Goat, a local software development 

and web design business.  They are members of the OKCPCUG. Comments or questions 
on the article are welcome and can be addressed to:   billy@smartgoat.com. 

There is no restriction against any non-profit group using this article as long as it 
is kept in context with proper credit given the author.  The Editorial Committee of the 
Association of Personal Computer User Groups (APCUG), an international organization of 
which this group is a member, brings this article to you. 

 

(Continued from page 14) 
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Hi!  I’m from the Government and I’m Here to 
Help Your Computer 
By Ira Wilsker 

Our computers are apolitical inanimate machines not influenced by 
our personal politics.  While we as individuals may differ in our beliefs of 
how much the government should be involved in our personal computing, 
there is an increasing amount of influence government agencies are hav-
ing in our routine computer utilization. 

 
Recently the U.S. Department of Homeland Security, acknowledg-

ing the role that our personal computers have in national security, an-
nounced a series of email alert services to notify us of potential cyber at-
tacks and other threats to our cyber infrastructure.   As has been ex-
plained previously in this column, our computers and net access have be-
come a potential target of terrorism, and can be utilized to launch cyber 
attacks without our knowledge.  As I type this, the Utah based software 
company SCO, has had its net access shut down because it was one of 
the targets of a denial of service attack launched from countless thou-
sands of computers infected with the “A” version of the MyDoom worm.  
The free alert system from the Department of Homeland Security, coinci-
dently announced as the MyDoom worm infected millions of machines 
and slowed down the net, is available both online and by email subscrip-
tion at www.us-cert.gov.  Warnings will be posted on this site, and 
emailed to subscribers as soon as they are released.  The free email 
alerts are listed at www.us-cert.gov/cas/index.html and distributed in 
four varieties.  Two of the alerts are highly technical versions, and two 
are non-technical “plain English” versions.  If you decide to subscribe to 
these free alerts, be sure to follow the subscription instructions explicitly.  
In order to prevent the unauthorized “spamming” of subscriptions, a dou-
ble opt-in process is utilized.  When you send the initial email subscrip-
tion, a confirming email will be sent by the email list server containing a 
unique reply code; be sure to follow the instructions exactly in that reply 
email in order to effect the subscription. 

 
The “Technical Cyber Security Alerts”, as listed on the US-

CERT.GOV website, “…provide timely information about current security 
issues, vulnerabilities, and exploits.”  The other technical alert is “Cyber 
Security Bulletins” which “…provide bi-weekly summaries of security is-
sues and new vulnerabilities. They also provide patches, workarounds, 
and other actions to help mitigate risk.” 

 
For those interested in less technical, but otherwise current and 

(Continued on page 17) 
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helpful information, a pair of non-technical alerts is available.  One is 
“Cyber Security Alerts” self-described as, “…provide(s) timely information 
about current security issues, vulnerabilities, and exploits … that affects 
the general public. … (and) outline(s) the steps and actions that non-
technical home and corporate computer users can take to protect them-
selves from attack.”  The other non-technical alert is “Cyber Security 
Tips” which “…describe(s) common security issues and offer advice for 
non-technical home and corporate computer users.” 

 
These alerts will contain a verifiable electronic signature to ensure 

that they are really valid alerts, and not some misleading spam intended 
to spoof authentic alerts and mislead victims.  Despite such precautions, 
there has been some concern that these alerts can still be falsified, lead-
ing to the type of damage that they are intended to warn about.  In a re-
cent statement released by Senator Charles Schumer (D-NY),  "If I were 
a betting man, I'd put a few dollars down that the next virus that clogs 
computer networks is going to be transmitted through an e-mail that 
looks like one of these DHS e-mail alerts."  

 
All four of these alerts, as well as the concurrent information 

posted on the US-CERT.GOV website, are intended to supplement, not 
replace, similar alerts already distributed by such cyber security compa-
nies as Symantec (Norton), Network Associates (McAfee), Panda, 
Sophos, F-Secure, Trend, and other publishers of antivirus, firewall, and 
internet security software and services. 

 
In a less fearsome mode, there is a helpful service available from 

the quasi-governmental agency, the U.S. Postal Service, to assist busi-
nesses, organizations, and individuals who mail items using “Priority” or 
“Express” mail.  Small quantity users can use a free online service “Click-
N-Ship” available at www.usps.com to generate and print mailing labels, 
complete with tracking number bar codes.   Larger volume users of Ex-
press and Priority mail can download a free utility, “USPS Shipping Assis-
tant Software” from the Postal Service to generate mailing labels on their 
own computers.  Available for free download from www.usps.com/
shippingassistant, this interesting utility can be used to track and confirm 
deliveries, verify zip codes, create mailing labels, calculate domestic and 
international postage, calculate delivery times, create and store address 
books, and even generate merchandise return labels.  The labels them-
selves, complete with barcodes for tracking, are typically printed one or 
two to an 8.5 x 11 sheet of self-adhesive labels.  Labels are available 
from the Postal Service website from a private contractor, our local office 

(Continued from page 16) 

(Continued on page 18) 
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supply stores, or online.  I recently used both the free online label ser-
vice, and the “USPS Shipping Assistant 2.2” I recently downloaded to 
prepare labels to mail merchandise to my kids.   I found both were easy 
to use and produced excellent quality labels on my printer.  I then used 
both the free online tracking on the USPS.COM website and the online 
tracking service integral with the Shipping Assistant software to track the 
packages, and both worked equally well. 

 
Now that computers have become a ubiquitous part of our daily 

lives, it is inevitable that we will see more governmental involvement and 
assistance with our daily computing. 

 
Ira Wilsker is the Advisor for Region 8, APCUG Representative & Bylaws Chair for 

the Golden Triangle PC Club, a columnist for The Examiner in Beaumont, Texas, and has 
two radio shows.  He also graciously shares his articles with the APCUG editors.    

There is no restriction against any non-profit group using this article as long as it 
is kept in context with proper credit given the author.  The Editorial Committee of the 
Association of Personal Computer User Groups (APCUG), an international organization of 
which this group is a member, brings this article to you. 
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IRS Again Offers Free Online Filing Services 
By Ira Wilsker  
 

We should have received all of our W-2’s, 1099’s, and other tax 
forms by now. Many of us struggle filling out tax forms manually, trying 
to decipher forms that have so many links and connections you feel that 
you have to be a genius octopus to connect all of the parts. Some of us 
use one of the popular tax software packages such as Tax Cut or Turbo-
Tax, and others use accountants or commercial services to prepare our 
most dreaded of forms.  

For those looking for an alternative, the IRS is again coordinating a 
variety of free online filing services. 

The logical starting place is the IRS website at www.irs.gov. At the 
top of the page is a link “Free File – Start Here for Free Online Filing”. 
Clicking on the link opens a new page with pre-filing tips, step-by-step 
instructions, and a “help center” with frequently asked questions.  

While the free filing services are coordinated and regulated by the 
IRS, the services themselves are provided by a number of individual 
profit seeking companies or non-profit organizations. Any company listed 
is prohibited from mandating the purchase of any additional services, and 
the listed services must be absolutely free to those qualified to use the 
services.  

The IRS site also states, “IRS Free File does not endorse Refund 
Anticipation Loans (RALs) or any other advance refund banking prod-
ucts”.  

The site also states that your privacy and financial information will 
be protected by the providers listed, and that these providers must meet 
commercial privacy and security standards, and be certified as such by a 
recognized issuer of privacy and security certifications. 

The process of getting started is a rather simple three step process.  
First is the “Start Now” button on the “Free Online Filing” web 

page; second is a determination of eligibility, as different providers have 
different requirements; finally the third step is linking to the private pro-
vider’s website, separate from the IRS site. If you find that you are ineli-
gible for a particular company’s free offerings, simply return to the IRS 
site and repeat the process by selecting another likely service. It should 
be noted that while millions of us are eligible for these free services, 
many of us will find that we are ineligible for any of many reasons. Once 
a satisfactory service has been selected, then the tax return information 
is completed online, with the completed documents being “e-Filed”, or 
electronically filed with the IRS. 

Fifteen online providers of free filing services are listed. Each has 
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its own requirements that may be based on residence, income, age, mili-
tary status, and other factors. While some services are clearly for lower 
income individuals, some of the free services are available for individuals 
who have an adjusted gross income (AGI) of up to $100,000. Some are 
available to residents of specific states, regardless of income level. None 
of the listed services offered free filing to Texas residents without regard 
to income level, though an even dozen of the services are available at no 
charge to Texas residents who meet other requirements. One of the ser-
vices, FreeTaxUSA, is listed as available to all Louisiana residents at no 
charge.  

Several of the companies listed provide free service to all active 
duty military personnel, regardless of residence or income. Some ser-
vices provide unrestricted service based on age, either younger than 
early 20’s, or older than 62 years of age. 

For those unsure about which service to consider, a button on the 
IRS page “Guide me To A Service!” uses a simple form to direct the user 
to appropriate services based on a short series of personal questions. 
These questions are age, estimated adjusted gross income, state of resi-
dence, number of W-2 forms, possibility of using a form 1040EZ, prob-
able eligibility for the “Earned Income Credit”, and military service. Once 
completed, a list of likely service providers is presented, allowing for the 
user to easily choose a provider. 

All of the providers in what the IRS refers to as the “Free File Alli-
ance” provide for electronic filing of tax returns. E-Filing, as the IRS calls 
it is relatively safe and secure, and, according to the IRS website, can 
generate refunds in as little as 10 days, with faster refund service avail-
able to those who select having their refunds direct deposited to their 
bank or credit union accounts. 

While these services are freely available online at no charge to 
many, they may not necessarily be the best alternative. Even if eligible to 
utilize one of these free services, the onus of decision making is solely on 
the individual, as most provide no comprehensive tax advice, meaning 
that it is quite possible for the user to miss deductions or credits that he 
may be eligible for, thus overpaying. It is also the responsibility of the 
user to accurately and completely enter data, as there is no one to verify 
the accuracy of the data entered. To use an early cyber cliché, “GIGO”, 
which means “Garbage in – Garbage Out”, the final return can only be as 
accurate as the information entered. 

Clearly, the free filing alternatives may be attractive to many indi-
viduals, but for many others the more traditional tax preparations re-
sources may be a superior alternative. The choice is yours; choose 
wisely. 

Ira Wilsker is the Advisor for Region 8, APCUG Representative & Bylaws Chair for 
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the Golden Triangle PC Club, a columnist for The Examiner in Beaumont, Texas, and has 
two radio shows.  He also graciously shares his articles with the APCUG editors.   

There is no restriction against any non-profit group using this article as long as it 
is kept in context with proper credit given the author.  The Editorial Committee of the 
Association of Personal Computer User Groups (APCUG), an international organization of 
which this group is a member, brings this article to you. 

 
 

PCI Express: Say Goodbye to AGP and PCI Slots 
By Timothy Everingham, TUGNET 

teveringham@acm.org 
 
Those of you who have been around personal computers for a while 

might remember plug in cards slots referred to as ISA, EISA, Microchan-
nel, and VESA Local Bus. ISA, EISA, and Microchannel were replaced by 
PCI. VESA Local bus was primarily for video cards, which was replaced by 
PCI, then AGP slots. It was a fun time during these card slot transitions 
because many times you could not use the plug in cards from your old 
machine in your new computer or motherboard or if you did it could slow 
down the entire system. Well guess what, its time to do it all over again. 
Intel has come up with a new slot standard PCI Express, which will start 
to show up in computers/motherboards this spring. 

 
PCI came out in 1992. Today these slots and its data bus technol-

ogy are used for things not envisioned when it was under development 
over 12 years ago. PCI has its limitations and the PCI pro slots never be-
came popular. The limitations are coming to the forefront in delivering 
multimedia content and Gigabit Ethernet. Of course getting higher frame 
rates at higher resolution and quality for video games also is an issue. 
PCI has been evolving over time increasing its speed to five times the 
original, but it has reached its limits of development. Many say that 
stretching out the AGP to 8x speed might be pushing at its limit too. 

 
First let us look at the current PCI architecture you will find on 

most motherboards. The CPU/Microprocessor   communicates with the 
first of two data bridges, normally referred to as the Memory Bridge or 
Northbridge. The Northbridge not only communicates with the CPU; but 
also communicates to the AGP port, which is where your main graphics 
card is (usually the only graphics card). It also communicates with your 
RAM. The fourth thing it communicates with is the second data bridge, 
known as the Input/Output (I/O) Bridge or Southbridge. The Southbridge 
also communicates to your plug in slots/cards, drive controllers, and 
USB, Fireware/1394, parallel. serial, game, keyboard and mouse ports. 
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The theoretical speed limit of the Southbridge communication to I/O in-
cluding the PCI slots is 133 MB/second. All of the communications in the 
system are parallel with none of the data having any priority over any 
other. Blocks of data have to be sent one at a time and cannot be done 
concurrently. Therefore the data is transferred from one section of the 
motherboard to the next section based on the order received, not the im-
portance or whether a piece of data arriving by a certain time to its desti-
nation is critical.  

 
PCI Express, instead of using a parallel bus architecture, uses serial 

networking typology with only two wires for each direction. At higher 
speeds, it allows concurrent transfer of data while having a similar look 
and the same type of Northbridge/Southbridge architecture as currently 
in desktops and laptops. 

 
However, in servers the Southbridge is eliminated producing 

greater data throughput. The PCI slots initially have a 250 MB/second 
throughput, but the scalable width technology (increasing the number of 
wire pairs) enables slots and cards to communicate at 32 times that 
speed in later implementations using longer slots. But the typology can 
also use network switching type technology, giving data priority and 
quality of service functions. Hot plug/swap of components is a native part 
of the architecture.  

 
The PCI Express Graphics Port, replacing the AGP Port, will have a 

4GB/second transfer rate in its initial configuration, double that of the 
current 8x AGP ports. For laptops units there will be a new plug-in card 
to replace PCMCIA called ExpressCard. It will come in two forms, one that 
more looks like a PCMCIA card refereed to at the 34 module form factor 
(34 x 75 x 5 mm) and a more oversized L looking card called the 54 
module form factor (54 x 75 x 5 mm). This new architecture is compati-
ble with existing operating systems. Also the new PCI Express slot is ca-
pable of being placed alongside current type PCI slots so a choice can be 
made which type of card can be used in a motherboard just like was done 
with ISA slots and current PCI slots. The standard PCI Express slots being 
put in motherboards this spring (1x) will be a lot shorter than the stan-
dard PCI slots.  

 
All of this will mean that a lot of issues having to do with multime-

dia on desktop and laptop computers will have been solved. It also opens 
wider use of Gigabit Ethernet on local area networks. It also enables the 
prospects of new motherboard form factors and computer case designs. 
As the transition from ISA to PCI was an interesting transition with com-
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puter buyers having to do more research and planning on their pur-
chases, the move from PCI to PCI Express will do the same. However, as 
was with the previous transition, the performance and capability in-
creases of computers will be profound. Further information on PCI Ex-
press can be found at www.express-lane.org. 

 
Timothy Everingham is CEO of Timothy Everingham Consulting in 

Azusa, California. He is also Vice Chair of the Los Angeles Chapter of ACM 
SIGGRAPHand is also on the Management Information Systems Program 
Advisory Board of California State University, Fullerton. In addition he is 
the Vice President of the Windows Media Users’ Group of Los Angeles. He 
is also part-time press in the areas of high technology, computers, video, 
audio, and entertainment/media and has had articles published through-
out the United States and Canada plus Australia, England, & Japan. Fur-
ther information can be found at http://home.earthlink.net/
~teveringham 

 
There is no restriction against any non-profit group using this article as long as it 

is kept in context with proper credit given the author.  The Editorial Committee of the 
Association of Personal Computer User Groups (APCUG), an international organization of 
which this group is a member, brings this article to you. 

 
Please note that we do not have “The Deals Guy” this 

month. 
Our meeting just comes too early for Bob Click to get his ar-

ticle out this soon. 
If I get it soon, I will send out a supplementary e-mail 

newsletter! 
Art McRowe, ACPCUG Newsletter editor 
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Club Officers    area code 330, unless noted otherwise 

President Murray Davis (2003) 440-248-
0021 

murray5050@yahoo.com 

Club Outreach Rick Lubinski (2002)  928-7179 lubinski@bright.net 

Secretary Walt Ruthenburg (2003)    283-7867 wruthenburg@usa.net 

Vice President and 
Program Director 

Frank Ramsey (2001) 699-4711 aframsey@yahoo.com 

Newsletter Editor Art McRowe 666-3189 acpcugnews@yahoo.com 

Software Evaluation     

Treasurer Jim Albright (2004) 923-8686 jra823a@netscape.net 

Upcoming Computer Shows: 
Peter Trapp at Tadmor Temple, Sunday, March 13th, 2004 
3000 Krebs Drive, Akron, OH.  
Exit 120 off I-77 (Arlington Rd.) 
Right on Jarvis. Right on Krebs to top of hill. 10am-3pm 

Note: Meeting Place: 
North Canton Public Library 
185 North Main Street 
North Canton, OH 44720 
 I-77 Exit (Portage) turn EAST. 
From Rt.77, take the Canal Fulton/North Canton Exit (Portage St.) 

Head east on Portage St. (If traveling north, you will turn right. If traveling south, you will turn left.) 
Follow Portage for approximately 1 1/4 miles to a sign that reads: "All thru traffic bear left."  
Do not bear left. Continue straight on Portage until it dead-ends at Ream St. 

Turn left on Ream. The Library is the 2nd building on your right. Small amount parking alongside and 
more across the street at rear of building. 

Please note change in contacting ACPCUG Newsletter Editor 
 New e-mail address:  acpcugnews@yahoo.com 


